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1. Enunciado 
 

Dado un componente de un freno de un vehículo, sometido a una presión en servicio de 

10 MPa (Figura 1), se pide determinar la rigidez del material del que tendría que 

fabricarse dicho componente para asegurar que el desplazamiento de cada una de sus 

secciones transversales sea siempre inferior a 5 mm. Con el resultado obtenido se pide 

proponer un material que resulte idóneo para tal aplicación. 

 

Condiciones del problema: 

 

El problema se resolverá utilizando ANSYS y teniendo en cuenta que: 

 

• La condición para resolver el problema es tensión plana. 

 

• Propiedades del material: El material es elástico e isótropo con un módulo elástico 

E (GPa) y coeficiente de Poisson =0.3. 

 

• Dimensiones del componente: Ver figura 2. 

 

• Presión de servicio: 10 MPa. 

 

• El espesor del elemento es de 20 mm. 

 

El problema se debe resolver utilizando un elemento PLANE183 2-D con el 

comportamiento correspondiente a tensión plana. Se dibuja la geometría según el plano 

de visualización XY (Figura 2). El elemento estará fijo en los dos orificios pequeños de 

la izquierda y tendrá una presión de 10MPa aplicada en el contorno inferior del orificio 

de mayor diámetro situado a la derecha.  

 

1) Determinar el módulo elástico mínimo que garantiza las condiciones del 

problema. 

 

2) Proponer posibles materiales para cumplir con la condición de diseño. 

 

 



PRÁCTICA 1: Simulación de un componente para un freno de un vehículo 

3 

 

 

 

 

 

 

 

Figura 1: Representación esquemática y simplificada del componente de freno. 

 

 

Figura 2: Geometría del problema a resolver con ANSYS. 

 

 

2. Preprocesamiento: Definir el problema 

 
1. Asignar título a la simulación: 

 

Menú Principal> Archivo> Cambiar título 

 

2. Generar la Geometría: 
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Las operaciones booleanas se utilizarán para crear la geometría básica del componente.  

 

a) Crear la forma rectangular principal  

 

La forma rectangular principal tiene un ancho de 80 mm, una altura de 100 mm y la 

esquina inferior izquierda se encuentra en las coordenadas (0,0). 

 

Preprocessor -> Modeling -> Create -> Areas ->Rectangle ->By Dimensions 

 

A continuación, se introducen las coordenadas de las esquinas del rectángulo:  

 

X1, X2: 0, 80 

Y1, Y2: 0, 100 

 

b) Generar el extremo circular en el lado derecho  

 

El centro del círculo se encuentra en (80,50) y tiene un radio de 50 mm. 

Para crear un área circular:  

 

Preprocessor -> Modeling -> Create -> Areas -> Circle-> Solid Circle 

 

A continuación, se introducen las coordenadas del centro, así como el valor del radio. 

 

c) Ahora crear los círculos de la izquierda con las siguientes dimensiones: 

Empleando la misma secuencia de opciones del menú del Preprocesador. 

 

parámetro círculo 2 círculo 3 

WP-X 0 0 

WP-Y 20 80 

RADIUS 20 20 

Tabla 1: Coordenadas y valor del radio de los círculos en mm. 

 

d) Crear un rectángulo en el extremo izquierdo para llenar la brecha entre los 

dos círculos pequeños.  

 

Preprocessor -> Modeling -> Create -> Areas ->Rectangle ->By 2 Corners 

 

XCORNER -20 

YCORNER 20 

ANCHO 20 

ALTURA 60 

Tabla 2: Coordenadas y dimensiones de los rectángulos en mm. 

 

e) La figura resultante debería ser similar a la siguiente: 
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Figura 3: Geometría resultante de las operaciones anteriores. 

 

f) Operaciones booleanas – Adición. 

 

Ahora se busca añadir estas cinco áreas diferenciadas entre sí para formar una sola área.  

Para realizar la operación booleana, en el menú se selecciona Preprocessor:  

 

Preprocessor -> Modeling -> Operate -> Booleans -> Add -> Areas 

 

En la ventana "Agregar Áreas", haga clic en 'Elegir todos": o bien seleccionando con el 

ratón una a una (opción Single), o bien dibujando con un ratón un cuadrado que englobe 

todas las áreas a unir (opción Box), o bien introduciendo en la ventana el número de las 

áreas a unir: 

 

 
Figura 4: Ventana para introducir el número de áreas a unir. 
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Ahora se debería ver el siguiente modelo: 

 

 
 

Figura 5: Modelo resultante de las operaciones booleanas. 

 

a) A continuación, es necesario crear los agujeros. 

 

Para crear los tres círculos con los parámetros indicados a continuación se sigue la 

secuencia de opciones vista anteriormente para crear círculos. 

 

parámetro círculo círculo 2 círculo 3 

WP-X 80 0 0 

WP-Y 50 20 80 

RADIO 30 10 10 

Tabla 3: Coordenadas y valor del radio de los agujeros en mm. 

 

A continuación, se selecciona:  

 

Preprocessor -> Modeling -> Operate -> Booleans -> Subtract -> Areas 

 

Se selecciona inicialmente el área de base de la que quiere sustraer otra área (la placa 

grande que se creó inicialmente). 

A continuación, haga clic en los tres círculos que acaba de crear y haga clic en 'Aceptar'. 

Ahora se debería tener lo siguiente: 
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Figura 6: Geometría final del componente de freno. 

 

3. Definir el tipo de elemento  
 

Para este ejemplo se empleará un elemento cuadrilátero de ocho nodos, cuya designación 

es PLANE183. Es posible mallar la geometría con formas degeneradas de este elemento 

como aparece en la figura. 

 

Figura 7: Tipos de elementos planos cuadrilátero y triangular con funciones de forma 

cuadráticas. 

 

Preprocessor -> Element Type -> Add / Edit / Delete 

 

 

Figura 8: Ventana para crear un nuevo tipo de elemento. 
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Seleccione la pestaña de Añadir (Add) y a continuación seleccione el tipo de elemento 

deseado: en este caso SOLID 8 node 183. 

 

 

Figura 9: Ventana para elegir el tipo de elemento. 

 

Use "Opciones ..." botón para obtener un elemento de tensión plana con un espesor. 

 

 

Figura 10: Ventana para elegir las características del elemento. 

 

4. Definir constantes geométricas 
 

Preprocessor -> Real Constants -> Add / Edit / Delete 

 

Se introduce un grosor de 20 mm. 
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Figura 11: Definición de parámetros. 

 

5. Propiedades del elemento material  

 
Inicialmente es necesario introducir un parámetro, que será el módulo elástico E del 

material. Para ello se selecciona la opción de Parameters del menú principal. A 

continuación, se escoge la opción de Scalar Parameters. En Selection se introduce un 

valor inicial arbitrario del módulo elástico: 𝐸 = 200000 𝑁/𝑚𝑚2. 

 

Preprocessor -> Material Props -> Material Models -> Material estructural -> lineal 

-> elástico -> isótropo 

 

Figura 12: Definición del modelo de material. 

 

Se deben introducir las propiedades del material que se han parametrizado anteriormente. 

Escriba lo siguiente cuando se le solicite: E, MU=0.3. 
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6. Tamaño de Malla  

 

Preprocessor -> Meshing -> Size Cntrls -> Manual Size -> Areas -> All Areas 

 

Seleccione un elemento de longitud de la arista de 5mm. 

 

 

Figura 13: Definición del tamaño de elemento de la malla. 

 

7. Malla  

 

Preprocessor -> Meshing -> Mesh -> Areas -> Free y seleccionar el área cuando se 

le solicite. 

 

Figura 14: Geometría mallada. 

 

8. Guardar su trabajo SAVE 

 

9. Finish 

 

10.  Fase de solución: Asignación de Cargas y resolución 
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Ahora es el momento de aplicar la presión y las restricciones y resolver el sistema 

resultante de ecuaciones. 

 

a) Definir el tipo de análisis  

 

"Un nuevo análisis", "Solution"> y seleccione 'Static'. 

 

b) Aplicar restricciones  

 

La placa se fija en dos de los agujeros más pequeños en el lado izquierdo.  

 

Solution -> Define Loads -> Apply -> Structural -> Displacement -> desplazamiento 

estructural>> En los nodos  

 

En lugar de seleccionar un nodo cada vez, tiene la opción de crear una caja, polígono o 

círculo en el que todos los nodos pertenecientes a la figura elegida serán seleccionados. 

Para este caso, seleccione "círculo", como se muestra en la ventana inferior. (Es posible 

que desee acercar la imagen para seleccionar los puntos de menu utility / PlotCtrls / Pan, 

Zoom, Rotate) Haga clic en el centro del agujero y arrastrar el círculo de modo que toque 

a todos los nodos situados en la frontera con el agujero.  

 

Figura 15: Selección de los nodos del agujero. 

 

Haga clic en “Apply” y a continuación seleccionar, en la siguiente ventana que se abre, 

la opción de “All DOF” (todos los grados de libertad impedidos) para los nodos 

seleccionados. 

Seguidamente, en el menú principal superior, se selecciona “Select Entities” y se abre la 

siguiente ventana en la que se selecciona Nodes -> Sele All -> OK. 
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Figura 16: Ventana para seleccionar nodos. 

 

Repita el procedimiento para el orificio del segundo perno. 

 

c) Aplicar cargas  

 
Como se muestra en el diagrama, hay una presión aplicada de 10 MPa en el semicírculo 

inferior del orificio de mayor diámetro. 

Para aplicar esta presión:  

 

Solution -> Define Loads -> Apply -> Structural -> Pressure -> On Lines 

 

Se seleccionan las dos líneas sobre las que se aplicará la presión (se debe recordar que 

realmente no son líneas sino planos de ancho 20mm): 

 

 

Figura 17: Ventana para aplicar una presión en líneas. 
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Finalmente, se resuelve mediante la opción: 

 

 Solve -> Current LS. 

 

Pulse Finish. 

 

11.  Fase de visualización: Campo de desplazamientos 

 
Para poder visualizar el campo de desplazamientos se opera de la siguiente manera: 

 

General Postproc ->Plot Results ->Contour Plot ->Nodal Solu (o también Element 

Solu). 

 

Se abre una ventana para poder seleccionar qué desplazamiento se quiere representar: 

 

 

Figura 18: Elección de las variables nodales a consultar. 

 

 

Figura 19: Representación gráfica sobre la figura de la variable nodal seleccionada. 
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Se escoge primero el desplazamiento en X y luego se representa el desplazamiento en Y, 

y se observa cuál es mayor (en valor absoluto). 

Para extraer el valor del desplazamiento máximo:  

 

General Postproc ->List Results ->Nodal Solution. 

 

Y se escogen los desplazamientos en X y en Y del nodo cuyo desplazamiento en cada una 

de las direcciones es el mayor de todos. Seguidamente hay que repetir el proceso de 

solución y visualización de resultados cambiando la rigidez del material, E, hasta 

conseguir un desplazamiento máximo (en X o en Y) de 5 mm.
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1. Introducción y objetivos 
 

En un problema estructural, si una de las dimensiones es significativamente mayor que 

las otras, el área de la sección transversal permanece uniforme y si la estructura o 

elemento está sometido únicamente a cargas laterales uniformes (como el caso de presas, 

muros de contención, etc.), entonces la suposición de deformación plana es válida. Con 

esta suposición, el número de nodos y elemento se reduce considerablemente, por tanto, 

la utilización del supuesto de deformación plana conduce a un considerable ahorro en el 

coste computacional sin pérdida de precisión en los valores de las variables de interés. 

Además, también se puede conseguir un considerable ahorro en el número de nodos y 

elementos si también se analizan las posibles simetrías que existen en el problema a 

analizar. Ello supondrá un ahorro adicional en el tiempo necesario de cálculo. 

El análisis de tensiones en una vasija cilíndrica hueca sometida a presión interior y 

constituida por dos materiales elasto-plásticos tiene como objetivo demostrar la utilidad 

de suponer condición de deformación plana y posibles simetrías, así como analizar el 

efecto de la plasticidad sobre el perfil de tensiones en ambos cilindros. 

 

2. Enunciado 
 

El problema a resolver consiste en la obtención del contorno de tensiones de un sistema 

constituido por dos cilindros concéntricos fabricados con distintos materiales elasto-

plásticos sometidos a presión interior mediante análisis por elementos finitos. 

Un depósito constituido por dos cilindros huecos de pared gruesa concéntricos y de 

distintos materiales elasto-plásticos, está sometido a una presión interior de valor, pa, tal 

y como se muestra en la Figura 1. El radio del orificio central es a, y los espesores del 

cilindro interior y exterior son (b-a) y (c-a), respectivamente. Se supone un contacto 

perfecto (sin deslizamiento) a lo largo de la unión de ambos tubos, lo que implica 

continuidad en el desplazamiento. Las propiedades de los cilindros interior y exterior son:  

 

• Cilindro interior: Material bilineal (Figura 2) con las siguientes propiedades: 𝐸1, 

𝜈1, 𝜎𝑦1, módulo tangente tg1. 

 

• Cilindro interior: Material bilineal (Figura 2) con las siguientes propiedades: 𝐸2, 

𝜈2, 𝜎𝑦2,  módulo tangente tg2. 

 
Datos: 

 

El problema se resolverá utilizando Ansys y teniendo en cuenta que: 
𝐸2

𝐸1
= 0.5 ; 𝜈1 = 𝜈2 = 0.33 ; 

𝑏

𝑎
= 2 ; 

𝑐

𝑎
= 4 ;  

𝜎𝑦1

𝜎𝑦2
= 0.3 ; 

𝑡𝑔𝜃2

𝑡𝑔𝜃1
= 0.5 con 𝑎 = 10 𝑚𝑚, 𝐸1 =

350 𝑀𝑃𝑎, 𝜎𝑦1 = 10 𝑀𝑃𝑎 y  𝑡𝑔𝜃1 = 3 𝑀𝑃𝑎 con 𝑝𝐴 = 20 𝑀𝑃𝑎. 

 

1) ¿Tiene lugar la plastificación en alguna zona del sistema constituido por ambos 

cilindros huecos?  

 

2) ¿Bajo las condiciones del problema, se produce una plastificación completa del sistema 

constituido por los dos cilindros huecos? 
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3) Determinar, si es posible, la magnitud del radio a partir de cual el comportamiento del 

sistema pasa de ser plástico a elástico.  

 

4) Determinar, si es posible el valor máximo de la presión que garantiza que la totalidad 

del sistema está en régimen elástico.  

 

 
Figura 1: Geometría del problema a resolver con Ansys. 

 

 
Figura 2: Modelo de material bilineal elasto-plástico. 

 

A continuación, se describen los pasos necesarios para la realización de los modelos de 

elementos finitos para la simulación del sistema descrito en el apartado anterior, que a 

grandes rasgos son los siguientes: 

 

1. Dibujo de la geometría. Considerar posibles simetrías, condiciones de tensión 

plana o deformación plana. 

 

2. Elección del tipo, o los tipos, de elementos que se utilizarán en la malla. 

 

3. Introducción de las propiedades geométricas de dichos elementos. 
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4. Definición de las propiedades del material o materiales. 

 

5. Realización de la malla sobre la geometría previamente definida. 

 

6. Imposición de las cargas y condiciones de contorno. 

 

7. Solución. 

 

8. Obtención de resultados. 

 

Los siguientes pasos constituyen la fase de preproceso. El penúltimo paso constituye la 

fase de solución. Finalmente, el último paso constituye la fase de postproceso. 

 

3. Preprocesamiento: Definir el problema 

 
Definición del entorno del problema: estático o dinámico; mecánico, térmico, de fluidos 

o combinación de ellos. 

 

 
Figura 3: Menú general de Ansys. 

 

Seleccionar: Preferences y dentro de esta pantalla seleccionar Structural. 

 

 
Figura 4:  Ventana para seleccionar el tipo de análisis. 
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Pulsar Ok. 

 

Definición de la geometría del problema: Para la definición de la geometría del 

problema propuesto sólo será necesario realizar una malla de la cuarta parte del sistema 

constituido por los dos tubos concéntricos huecos dada la simetría del problema. Además, 

dado que la longitud de los cilindros es muy grande en comparación con las demás 

dimensiones, el problema tridimensional se puede reducir a un problema en dos 

dimensiones en condiciones de deformación plana. Sobre esta geometría se definirán una 

malla fina con elementos cuadriláteros de aproximación lineal (cuatro nodos). La 

geometría del problema se muestra en la Figura 3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 5: Geometría del sistema teniendo en cuenta las simetrías. 

 

Para definir la geometría se utilizará el módulo de preproceso del programa 

(Preprocessor). Se deben introducir en primer lugar los puntos maestros (Keypoints) 

utilizando para ello el menú que aparece a la izquierda de la pantalla: 

 

Seleccionar: Preprocessor y dentro de esta pantalla seleccionar la pestaña Modeling. A 

continuación, dentro del menu de Modeling selecionar Create. Seguidamente se 

selecciona la opción de Keypoints On Working Plane (crear puntos maestros en el plano 

de trabajo) 

 

Preprocessor->Create->Keypoint->On Working Plane 

 

A continuación, se teclean las coordenadas de los seis puntos en la ventana marcada en la 

siguiente figura y finalmente se pulsa Ok. 

 

 

 

1 2 3 4 

5 

6 

7 
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Figura 6: Ventana para introducir los nodos por coordenadas. 

 

Coordenadas de los nodos: 

 

1: (0,0) 

2: (10,0) 

3: (20,0) 

4: (40,0) 

5: (0,40) 

6: (0,20) 

 

 

Figura 7: Puntos en el plano de trabajo después de haber introducido las coordenadas. 
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El siguiente paso es definir las líneas que unen los puntos. En primer lugar, se introducen 

los arcos mediante la siguiente serie de acciones: 

 

Alternativa 1: 

 

1. Preprocessor->Create->Arcs->By End Kps & Radius 

2. Picar en pantalla los puntos 2 y 7 (puntos inicial y final) 

3. Pulsar Enter 

4. Picar el punto 1 (punto central) 

5. En el diálogo que aparece rellenar el valor del radio. 
 

Alternativa 2: 

 

1. Preprocessor->Create->Arcs->By Cent & Radius 

2. Teclear las coordenadas del centro (0,0) y del punto inicial 

(a,0) 

3. En el menú que aparece introducir el ángulo (90 grados) y el número de líneas 

en las que se va a dividir el mismo (4 líneas). Automáticamente se crean las líneas 

y los puntos asociados a ellas. 

 

Dentro del menu Create: Seleccionar: Lines y dentro de esta desplegable seleccionar la 

pestaña Arcs. A continuación, dentro del menu de Arcs seleccionar By End Kps & 

Radius. Seguidamente aparece una pantalla en la que se piden los Nodos Maestros 

(Keypoints) que delimitan el arco (por ejemplo, el primer arco estará limitado por los 

nodos 2 y 7) seleccionándolos con el ratón. Seguidamente se selecciona el centro del arco 

(para todos los arcos el centro es el nodo 1 de coordenadas 0,0). A continuación, se abre 

una nueva ventana donde hay que introducir el valor del radio (por ejemplo, el primer 

arco tiene un radio 10m).  

 

 

Figura 8: Creación de un arco a través de su centro y sus puntos de inicio y fin. 

 



PRÁCTICA 2: Deformación plástica 

22 

 

En la figura siguiente se muestran todos los arcos necesarios para la geometría del 

problema. 

 

 

Figura 9: Representación de todos los arcos creados. 

 

Para finalizar se introducen las líneas rectas, definiéndolas de punto a punto: 

 

1. Preprocessor->Create->Lines->Straight line. 

2. Ir picando los extremos iniciales y finales de las líneas. Al finalizar pulsar OK en 

el menú que se ha desplegado. 

 

Dentro del menú de Create, seleccionar Lines; y dentro del menú de Lines, seleccionar 

Straight Lines. Con el ratón se seleccionan los nodos extremos de las líneas generando 

todas ellas tal y como se muestra en la siguiente figura: 

 

 

Figura 10: Representación de los arcos unidos con líneas. 
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A partir de estas líneas se creará un área sobre la que se definirá la malla. 

 

1. Preprocesor->Create->(Areas)Arbitrary->By Lines 

2. Picar con el ratón las líneas que componen el contorno de cada área. 

 

Se deben generar un total de 2 áreas (dos sectores circulares) seleccionando las líneas que 

las limitan. 

Dentro del menú de Create, seleccionar Areas; y dentro del menú de Areas, seleccionar 

Arbitrary; y dentro de éste seleccionar By Lines. Con el ratón se seleccionan las líneas 

que limitan cada área generando todas ellas tal y como se muestra en la siguiente figura: 

 

 

Figura 11: Representación de las dos áreas creadas. 

 

Antes de proceder a generar la malla, es necesario elegir el tipo de elemento que se va a 

utilizar. 

 

Preprocesor->Element Type->Add/Edit/Delete. 

 

4. Elección del tipo de elementos 
 

Se despliega el menú de tipos de elementos. Pulsando sobre el botón Add se abre la 

librería de elementos. Para la malla cuadrática se debe seleccionar el PLANE 42, de 

cuatro nodos. Finalmente, pulsar Ok. 

A continuación, se eligen las características principales del tipo de elemento 

seleccionado. 

Pulsando el botón Options se pueden modificar las opciones por defecto de los elementos 

para indicar que se trata de elementos de deformación plana con espesor (Plane strain). 
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Figura 12: Selección de las características del elemento. 

 

Una vez elegido el elemento hay que determinar sus características geométricas 

adicionales a través del menú de Real Constants: 

 

Preprocesor->Real Constants 

 

En este caso, y por tratarse de elementos para deformación plana no es necesario 

introducir ninguna característica geométrica adicional. 

 

5. Definición de los materiales 
 

Posteriormente se deben dar las propiedades del material necesarias, teniendo mucho 

cuidado con que el sistema de unidades escogido para cada una sea coherente con el 

utilizado en el resto del modelo.  

Para definir el material, se selecciona en el menú: 

 

Preprocessor->Material Props->Material Models. 

 

Al hacerlo aparece un diálogo con distintos tipos de modelos de material. Hay que elegir 

el modelo y dos pasos. El primero consiste en definir las propiedades elásticas. Para ello 

dentro del menú de propiedades del material se selecciona el modelo: 

Structural \ Linear \ Elastic \ Isotropic, tras lo que se despliega la ventana de propiedades, 

en la que se introducen los valores deseados de módulo de Young y coeficiente de 

Poisson. 
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Figura 13: Introducción del módulo de Young y coeficiente de Poisson. 

 

A continuación, se introducen las propiedades plásticas seleccionando un material: 

Structural \ Nonlinear \ Inelastic \ Rate Independent \ Isotropic Hardening Plasticity \ 

Bilineal (material estructural inelástico independiente de la velocidad con endurecimiento 

isótropo y constituido por dos ramas: una elástica y otra lineal plástica). 

 

 

Figura 14: Introducción de la parte práctica del modelo de material. 

 

Definir un segundo material y repetir el proceso cambiando los valores de las 

propiedades: 
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Figura 15: Definición del segundo material. 

 

6. Mallado 
 

Una vez llegados a este punto, ya es posible definir la malla. Para este modelo, lo más 

cómodo será realizar un mallado semiautomático de las regiones definidas como sectores 

circulares: 

Dentro del menú general Preprocessor, seleccionar la opción de Meshing. Dentro de 

Meshing seleccionar la opción de MeshTool: 

 

Preprocessor->MeshTool. 

 

En la parte derecha de la pantalla aparece un menú con todos los comandos necesarios 

para generar y deshacer mallas. Con los botones de su parte superior se asignan los 

atributos de los elementos que se van a utilizar. Es decir que es necesario definir para 

cada sector circular el tipo de elemento y propiedad del material que le corresponde 

según las condiciones del problema. 

Pulsando el botón Set se pueden seleccionar los distintos elementos geométricos cuyas 

propiedades de mallado se van a fijar. Es decir, si se selecciona Global quiere decir que 

todos los elementos geométricos van a tener el mismo tipo de elemento y el mismo 

material; si se selecciona Area, quiere decir que sólo las áreas seleccionadas con el ratón 

son las que tendrán el tipo de elemento y el material definidos. 

En el caso del problema se irán seleccionando cada área y se irán eligiendo el tipo de 

elemento y material correspondiente: 
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Figura 16: Elección del tipo de elemento según el área seleccionada. 

 

El siguiente bloque de botones permite definir el tamaño de los elementos que se van a 

utilizar. Para una malla lineal se debe definir un tamaño global de 2 mm y un tamaño de 

1 mm para las curvas. 

El procedimiento general para definir el tamaño de los elementos en cada parte del 

modelo es el siguiente: 

 

Se selecciona el área 1: 

 

 

 

Figura 17: Selección del primer área para asignar el tamaño del elemento. 

 

Y se procede a elegir el tipo de elemento y material correspondiente a esta área: 
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Figura 18: Selección del tipo de material y del tipo de elemento para el área seleccionada. 

 

En este caso el Material es el 1 y el tipo de elemento Plane42. 

Se repite este proceso para el área 2. 

El procedimiento general para definir el tamaño de los elementos en cada parte del 

modelo es el siguiente: 

 

1. Dentro de la zona Size Control perteneciente a la ventana MeshTool, pulsar 

el botón (Lines) ->Set. 

 

2. Seleccionar las líneas cuyo tamaño de elemento se van a definir. Por ejemplo, 

seleccionar los arcos del área 1. 

 

3. Introducir el tamaño del elemento en la casilla ESIZE del diálogo que se 

muestra poniendo un valor de 1 mm: 

 

 

 

Figura 19: Ventana para introducir el tamaño del elemento. 
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4. Pulsar el botón ->Ok. 

 

5. Repetir el proceso sobre el arco del área 2. 

 

6. Sobre las líneas verticales y horizontales, escoger un valor para el tamaño de 

elemento de 0,5 mm, y repetir el proceso anterior. 

 

7. Dentro de la zona de Mesh, se selecciona Area, ya que lo que se va a mallar 

son áreas. A continuación, se selecciona la opción de Quad y Mapped dentro 

de Shape. Es decir, se seleccionan elemento cuadriláteros para realizar el 

mallado y además la forma de mallar las áreas es de manera regular ya que 

dichas áreas tienen una forma regular. 

 

8. Por último, pulsando el botón Mesh y seleccionando el área con el ratón, se 

consigue realizar el mallado de ambas áreas. 

 

 

Figura 20: Geometría mallada. 

 

7. Imposición de las cargas y condiciones de contorno. 

 
El siguiente paso consistirá en la imposición de cargas y condiciones de apoyo. Estas 

operaciones se realizan dentro del módulo de cálculo del programa (Solution).  

Dentro del menú de Solution, seleccionar la opción de Define Loads para definir las 

condiciones de contorno (simetrías) y la presión uniforme interna. 

Para inmovilizar la probeta se definirán las condiciones de apoyo correspondientes a la 

simetría del problema que son: simetría respecto del plano xz (SY) en la cara inferior y 

respecto del plano yz (SX) en la cara izquierda: 

 

1. Solution->(Loads) Apply->Displacement->(Symmetry B.C.) On Lines. 
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2. Seleccionar con el ratón las líneas que están sobre los ejes de simetría. 

 

3. Se impiden los desplazamientos en dirección perpendicular al plano de 

simetría. 

 

La carga a aplicar es una presión de 20 MPa. La presión se aplicará sobre los elementos 

situados en el arco interior del área 1. 

Para aplicar la presión, seguir los siguientes pasos: 

 

1. Solution->(Loads) Apply->Pressure->On Lines. 

 

2. Seleccionar con el ratón la línea de aplicación de la presión. 

 

3. Seleccionar la opción de presión constante: Constant Value. 

 

4. Imponer el valor de la presión con signo positivo. 

 

5. Pulsar OK. 

 

8. Solución 
 

Para resolver el problema se escoge en el menú: 

 

Solution->(Analysis Type) New Analysis->Static->OK. 

 

Como el tubo va a sufrir plasticidad es necesario fijar un valor máximo de plasticidad. 

Para ello se sigue en siguiente itinerario: 

 

Solution->Analysis Type->Sol’n Controls->Nonlinear->Equiv. Plastic Strain: 1. 

 

De esta manera se selecciona el tipo de cálculo que se va a realizar, que en este caso es 

estático, lineal y con plasticidad. A continuación, se debe seleccionar: 

 

Solution->(Solve)->Current LS. 

 

Se abre una ventana blanca resumiendo algunos datos de la simulación y una ventana 

verde indicando que, si después de leer el resumen se está de acuerdo con el tipo de 

cálculo, pulsando OK en la ventana verde se iniciará el cálculo.  

Cuando el cálculo ha terminado se muestra el mensaje “Solution is done”. Hay que pulsar 

OK y cerrar la ventana blanca que ha aparecido al iniciar el cálculo: File->Close. 
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9. Obtención de resultados 
 

Para visualizar los resultados del análisis hay que utilizar el módulo de postproceso del 

programa (General Postproc). 

Resultan especialmente interesantes los valores de tensión a lo largo de los planos de 

simetría (σ), que permitirán calcular si ha tenido lugar la plastificación en alguna zona. 

Para obtener los contornos para σxx y σyy es necesario utilizar el siguiente itinerario de 

menús: 

 

General Postproc->Plot Results-> Contour Plot->Nodal Solution y elegir la tensión 

en el eje x (Stress SX). 

 

El postprocesador puede presentar mapas de resultados, o bien listados con sus valores 

numéricos. 

Para listar las componentes de la tensión utilizar: 

 

General Postproc->List Results-> Nodal Solution y seleccionar las componentes de 

la tensión (Stress Components SCOMP). 

 

Puesto que el problema presenta geometría circular, es más útil examinar las tensiones en 

coordenadas cilíndricas. Para este propósito, es necesario cambiar los resultados del 

sistema coordenado cartesiano al sistema cilíndrico, a través del siguiente itinerario: 

 

Main Menu->General Postproc->Options for Outp. 

 

La ventana correspondiente a opciones de presentación de resultados (Options for 

Output) aparece. Hay que seleccionar Global cylindric y pulsar Ok. 

A continuación, se pueden obtener los contornos de σrr y σθθ a través del siguiente 

itinerario: 

 

Main Menu->General Postproc->Plot Results->Nodal Solu. 

 

Seleccionar Stress y X-direction. El contorno de dichas tensiones debe aparecer en la 

ventana de gráficos. Hay que repetir el proceso para obtener σθθ. Para obtener la variación 

de las tensiones a lo largo de un camino definido por una línea, hay que seguir el siguiente 

itinerario: 

 

Main Menu->General Postproc->Path Operations->Define Path->By Nodes. 

 

Aparece el menú de selección Pick Menu. A continuación, se seleccionan los nodos con 

coordenadas (x, y) que definen la línea, y se pulsa Ok. El camino se extiende a lo largo 

del eje positivo de las x e y, comenzando desde el contorno del agujero hasta la superficie 

externa del sistema.  

La ventana By Nodes aparece. Hay que introducir un nombre que describa el camino, por 

ejemplo cil1, en el campo de texto: Define Path Name, y pulsar Ok. 

Se pueden presentar los resultados sobre el camino definido a través del siguiente 

itinerario: 
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Main Menu->General Postproc->Path Operations->Map onto Path. 

 

Seleccionar Stress y dirección Y-direction SY, y pulsar Ok. 

Se puede obtener la línea de variación de las tensiones σθθ a lo largo del camino definido 

mediante el siguiente itinerario: 

 

Main Menu->General Postproc->Path Operations->Plot Path Item->On Graph. 

 

A continuación, se selecciona SY y se pulsa Ok.
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1. Enunciado 
 

Una placa de grandes dimensiones (de espesor infinito) con una grieta central pasante se 

somete a una tensión de tracción σ0 final como se muestra en la Figura 1. Imponiendo las 

condiciones de simetría adecuadas, determinar el factor de intensidad de tensiones KI. 

 

Datos: 

 

• El problema se resolverá utilizando Ansys y teniendo en cuenta: 

 

• Propiedades del material: El material es elástico e isótropo con un módulo elástico 

𝐸 = 200 𝐺𝑃𝑎 y coeficiente de Poisson 𝜈 = 0.3. 

 

• Dimensiones de la placa: 2𝑎 = 50 𝑚𝑚, 2𝑏 = 500 𝑚𝑚 y 2ℎ = 500 𝑚𝑚. 

 

• La tensión aplicada es de 100 MPa. 

 

El problema se debe resolver utilizando un elemento PLANE183 2-D con el 

comportamiento correspondiente a deformación plana. Se dibuja sólo una cuarta parte del 

modelo al tener en cuenta las condiciones de simetría (Figura 2). La placa se somete a 

una tensión de tracción y los valores de la integral J se calculan para los nodos del fondo 

de fisura. De los valores de la integral J se calcula el factor de intensidad de tensiones. 

 

1) Determinar el factor de intensidad de tensiones. 

 

2) Determinar cómo varía el factor de intensidad de tensiones si el problema se 

resuelve en condiciones de tensión plana. Discutir el resultado. 

 

 
Figura 1: Geometría del problema a resolver con Ansys. 

 

 



PRÁCTICA 3: Determinación del factor de intensidad de tensiones 

35 

 

 

 

Figura 2: Geometría final a simular teniendo en cuenta las simetrías. 

 

A continuación, se describen los pasos necesarios para la realización de los modelos de 

elementos finitos para la simulación del sistema descrito en el apartado anterior, que a 

grandes rasgos son los siguientes: 

 

1. Dibujo de la geometría. Considerar posibles simetrías, condiciones de tensión 

plana o deformación plana. 

 

2. Elección del tipo, o los tipos, de elementos que se utilizarán en la malla. 

 

3. Introducción de las propiedades geométricas del modelo. 

 

4. Definición de las propiedades del material o materiales. 

 

5. Realización de la malla sobre la geometría previamente definida. 

 

6. Imposición de las cargas, condiciones de contorno y simetrías. 

 

7. Solución. 

 

8. Obtención de resultados. 

 

Los pasos 1-6 constituyen la fase de preproceso. El paso 7 constituye la fase de solución. 

Finalmente, el paso 8 constituye la fase de postproceso. 

 

2. Preprocesamiento: Definición del problema 
 

Seleccionar: Preferences y dentro de esta pantalla seleccionar Structural. 

 



PRÁCTICA 3: Determinación del factor de intensidad de tensiones 

36 

 

 

Figura 3: Ventana para seleccionar el tipo de análisis. 

 

Pulsar Ok. 

 

Definición de la geometría del problema: Para la definición de la geometría del 

problema propuesto sólo será necesario realizar una malla de la cuarta parte del sistema 

dada la simetría del problema. Además, dado que el espesor de la placa es muy grande en 

comparación con las demás dimensiones, el problema tridimensional se puede reducir a 

un problema en dos dimensiones en condiciones de deformación plana. Sobre esta 

geometría se definirán una malla fina con elementos cuadriláteros de aproximación 

cuadrática (ocho nodos). La geometría del problema se muestra en la Figura 2. 

Para definir la geometría se utilizará el módulo de preproceso del programa 

(Preprocessor). Se deben introducir en primer lugar los puntos maestros (Keypoints) 

utilizando para ello el menú que aparece a la izquierda de la pantalla: 

Seleccionar: Preprocessor y dentro de esta pantalla seleccionar la pestaña Modeling. A 

continuación, dentro del menú de Modeling seleccionar Create. Seguidamente se 

selecciona la opción de Keypoints On Working Plane (crear puntos maestros en el plano 

de trabajo) 

 

Preprocessor->Create->Keypoint->On Working Plane. 

 

A continuación, se teclean las coordenadas de los cinco puntos que determinan la 

geometría del problema (Figura 4). 

 

 

Figura 4: Geometría y nodos maestras del problema a resolver. 
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Coordenadas de los nodos: 

 

1: (0,0) 

2: (25,0) 

3: (250,0) 

4: (250,250) 

5: (0,250) 

 

 

Figura 5: Representación de los nodos maestros dibujados. 

 

El siguiente paso es definir las líneas que unen los puntos. 

 

1. Preprocessor->Create->Lines->Straight line. 

 

2. Ir picando los extremos iniciales y finales de las líneas. Al finalizar pulsar OK 

en el menú que se ha desplegado. 

 

Dentro del menú Create: Seleccionar: Lines y dentro de esta desplegable seleccionar 

Lines. A continuación, señalar la opción de Straight Line. Para la línea 1 seleccionar los 

nodos 1 y 2; para la línea 2, los nodos 2 y 3; para la línea 3, los nodos 3 y 4; para la línea 

4, los nodos 4 y 5; y finalmente para la línea 5, los nodos 5 y 1. 

 

 



PRÁCTICA 3: Determinación del factor de intensidad de tensiones 

38 

 

 

Figura 6: Líneas creadas a través de los puntos maestros. 

 

A partir de estas líneas se creará un área sobre la que se definirá la malla: 

 

1. Preprocesor->Create->(Areas)Arbitrary->By Lines. 

 

2. Picar con el ratón las líneas que componen el contorno de cada área. 

 

Se deben generar un total de 1 área seleccionando las líneas que las limitan. 

Dentro del menú de Create, seleccionar Areas; y dentro del menú de Areas, seleccionar 

Arbitrary; y dentro de éste seleccionar By Lines. Con el ratón se seleccionan las líneas 

que limitan el área tal y como se muestra en la siguiente figura: 

 

 

Figura 7: Área creada a través de las líneas. 
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3. Elección del tipo de elementos 
 

Antes de proceder a generar la malla, es necesario elegir el tipo de elemento que se va a 

utilizar. 

 

Preprocesor->Element Type->Add/Edit/Delete. 

 

Se despliega el menú de tipos de elementos. Pulsando sobre el botón Add se abre la 

librería de elementos. Para la malla cuadrática se debe seleccionar el PLANE 183, de 

ocho nodos. Finalmente, pulsar Ok. 

 

 

Figura 8: Selección del tipo de elemento. 

 

Pulsando el botón Options se pueden modificar las opciones por defecto de los elementos 

para indicar que se trata de elementos de deformación plana con espesor (Plane strain). 

 

 

Figura 9: Selección de las características del elemento. 
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Una vez elegido el elemento hay que determinar sus características geométricas 

adicionales a través del menú de Real Constants: 

 

Preprocesor->Real Constants. 

 

En este caso, y por tratarse de elementos para deformación plana no es necesario 

introducir ninguna característica geométrica adicional. 

 

4. Definición de los materiales 
 

Posteriormente se deben dar las propiedades del material necesarias, teniendo mucho 

cuidado con que el sistema de unidades escogido para cada una sea coherente con el 

utilizado en el resto del modelo.  

Para definir el material, se selecciona en el menú: 

 

Preprocessor->Material Props->Material Models. 

 

Al hacerlo aparece un diálogo con distintos tipos de modelos de material. Hay que definir 

las propiedades elásticas. Para ello dentro del menú de propiedades del material se 

selecciona el modelo: 

Structural \ Linear \ Elastic \ Isotropic, tras lo que se despliega la ventana de propiedades, 

en la que se introducen los valores deseados de módulo de Young y coeficiente de 

Poisson. 

 

 

Figura 10: Introducción del módulo de Young y del coeficiente de Poisson para un material 

isótropo. 

 

5. Mallado 
 

Una vez llegados a este punto, ya es posible definir la malla. Para este modelo, lo más 

cómodo será realizar un mallado semiautomático: 

Dentro del menú general Preprocessor, seleccionar la opción de Meshing. Dentro de 

Meshing seleccionar la opción de MeshTool: 

 



PRÁCTICA 3: Determinación del factor de intensidad de tensiones 

41 

 

Preprocessor->MeshTool. 

 

En la parte derecha de la pantalla aparece un menú con todos los comandos necesarios 

para generar y deshacer mallas. Con los botones de su parte superior se asignan los 

atributos de los elementos que se van a utilizar. Es decir que es necesario definir el área 

dibujada el tipo de elemento y propiedad del material que le corresponde según las 

condiciones del problema. 

Pulsando el botón Set se pueden seleccionar los distintos elementos geométricos cuyas 

propiedades de mallado se van a fijar. Es decir, si se selecciona Global quiere decir que 

todos los elementos geométricos van a tener el mismo tipo de elemento y el mismo 

material; si se selecciona Area, quiere decir que sólo las áreas seleccionadas con el ratón 

son las que tendrán el tipo de elemento y el material definidos. 

Y se procede a elegir el tipo de elemento y material correspondiente a esta área: 

 

 

Figura 11: Selección del tipo de material y de elemento para la región seleccionada. 

 

El siguiente bloque de botones permite definir el tamaño de los elementos que se van a 

utilizar. 

Se define un tamaño de elemento de 25 mm para las líneas 2, 3 y 4: 

 

 

Figura 12: Tamaño del elemento para las líneas 2, 3 y 4. 
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Para la línea 5 se realiza un mallado con relación de espaciado. Es decir, un mallado en 

el que el tamaño de elemento disminuya desde el nodo 5 hasta el nodo 1. Para ello, se 

establece un tamaño de elemento Element Edge length de 15 y un Spacing ratio de 0.2. 

 

 

Figura 13: Tamaño del elemento para la línea 5. 

 

Seguidamente es necesario generar elementos concentrados sobre el fondo de fisura 

(nodo 1). La concentración de estos elementos es necesaria para tener en cuenta la 

singularidad en el fondo de fisura. 

Dado que existe una singularidad en el fondo de la fisura, interesa que los elementos 

finitos de su alrededor incorporasen en sus funciones de forma este tipo de singularidad, 

para así reproducir con mayor exactitud la solución en la región dominada por la 

singularidad. El tipo de singularidad depende del modelo de material que se emplee en el 

análisis. Para materiales elásticos lineales, la singularidad en la deformación es del tipo 

𝜀 ∝
1

√𝑟
. Para que los elementos finitos que están en contacto con el frente de fisura 

presenten esta singularidad en la deformación, es necesario que los nodos de los 

elementos del fondo de fisura estén colapsados en uno, es decir, que los elementos 

cuadriláteros se transforman en elementos triangulares mediante el colapso de los nodos 

de una cara, nodos que estarán en contacto con el fondo de fisura.  

Además, es necesario también que los nodos intermedios se desplacen hacia el vértice de 

los elementos triangulares. 

 

 

Figura 14: Desplazamiento de los nodos intermedios hacia el vértice en un elemento triangular. 
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Ansys proporciona una forma de concentrar elementos alrededor de un punto con la 

singularidad descrita. Para ello es necesario seguir el siguiente itinerario: 

 

Preprocessor->Meshing->Size Cntrls->Concentrat KPs->Create. 

 

A continuación, se selecciona el nodo maestro correspondiente al fondo de fisura (nodo 

1) y se abre una ventana en la que es necesario definir las siguientes propiedades 

relacionadas con el mallado alrededor de este punto: 

 

 

Figura 15: Definición de las propiedades de mallado alrededor del nodo maestro. 

 

• El primer recuadro en blanco hace referencia al nodo alrededor del cual se 

dispondrán los elementos con la singularidad (valor 2). 

 

• El segundo recuadro en blanco hace referencia al radio de la primera fila de 

elementos que rodearán al nodo 1. En este caso se fija un valor de 1 mm. 

 

• El tercer recuadro en blanco hace referencia al radio de la segunda fila de 

elementos que rodearán al nodo 1. En este caso se fija un valor de 3 mm. 

 

• En el cuarto recuadro blanco se fija el número de elementos alrededor del nodo 1. 

En este caso se fijarán 10 elementos. 

 

• El quinto recuadro blanco permite mover los nodos intermedios hacia el vértice. 

Para ello se selecciona la opción Skewed 1/4pt. 

 

Definidos los tamaños de elemento, así como las condiciones de singularidad, lo siguiente 

es generar el mallado. Para ello se sigue el siguiente itinerario: 

 

Preprocessor->Meshing->Mesh->Areas->Free. 

 

Y se selecciona el área. A continuación, se pulsa Ok. 
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6. Imposición de las cargas y condiciones de contorno 
 

El siguiente paso consistirá en la imposición de cargas y condiciones de contorno. Estas 

operaciones se realizan dentro del módulo de cálculo del programa (Solution).  

Dentro del menú de Solution, seleccionar la opción de Define Loads para definir las 

condiciones de contorno (simetrías) y la tensión uniforme. 

Las simetrías del problema son: simetría respecto del plano xz (SY) en la cara inferior, 

seleccionando la línea que no representa a la fisura, y respecto del plano yz (SX) en la 

cara izquierda: 

 

1. Solution->(Loads) Apply->Displacement->(Symmetry B.C.) On Lines. 

 

2. Seleccionar con el ratón las líneas que están sobre los ejes de simetría. De esta 

forma se impiden los desplazamientos en dirección perpendicular al plano de 

simetría. 

 

3. Se impide el desplazamiento en X del nodo 2 (fondo de fisura):                      

Solution->(Loads) Apply->Displacement->On Nodes. 

 

Y se selecciona la opción de UX imponiendo un desplazamiento de 0 para impedir un 

desplazamiento del fondo de fisura, lo que supondría una propagación de la grieta. Hay 

que tener en cuenta que el cálculo del factor de intensidad de tensiones se ha de hacer 

cuando la grieta no propaga: 

 

 

Figura 16: Restricción del desplazamiento horizontal en el fondo de fisura. 

 

La carga a aplicar es una presión de 100 MPa. La presión se aplicará sobre la línea 

superior. 

Para aplicar la presión, seguir los siguientes pasos: 
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1. Solution->(Loads) Apply->Pressure->On Lines. 

 

2. Seleccionar con el ratón la línea de aplicación de la presión. 

 

3. Seleccionar la opción de presión constante: Constant Value. 

 

4. Imponer el valor de la presión con signo negativo. 

 

5. Pulsar OK. 

 

7. Solución 
 

Para resolver el problema se escoge en el menú: 

 

Solution->(Analysis Type) New Analysis->Static->OK. 

 

De esta manera se selecciona el tipo de cálculo que se va a realizar, que en este caso es 

estático, lineal. 

Se procede a llevar a cabo la solución del problema: 

 

Solution->(Solve)->Current LS. 

 

Cuando el cálculo ha terminado se muestra el mensaje “Solution is done”. Hay que pulsar 

OK y cerrar la ventana blanca que ha aparecido al iniciar el cálculo: File->Close. 

 

8. Obtención de los resultados 
 

Se define el camino de la grieta: 

 

Main Menu>General Postproc>Path Operations>Define Path>By Nodes. 

 

Se seleccionan los tres primeros nodos desde el fondo de fisura hacia la grieta. 

Se selecciona un nombre para el camino: Define Path Name: K1. 

 

 

Figura 17: Definición de un camino por nodos. 
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Se define un  sistema de coordenadas local en el fondo de la grieta: 

 

Utility Menu>WorkPlane>Local Coordinate Systems>Create Local CS>By 3 

Nodes. 

 

Y se seleccionan los nodos: fondo de fisura, el siguiente en dirección X y el siguiente en 

dirección Y. 

 

 

Figura 18: Creación de un sistema de coordenadas local por tres puntos. 

 

El número de referencia para el nuevo sistema coordenado es 11. 

Activar el sistema coordenado local 11: 

 

Utility Menu>WorkPlane>Change Active CS to>Specified Coord Sys ... 

 

 

Figura 19: Activación del nuevo sistema de coordenadas local. 

 

Activar el sistema coordenado del fondo de fisura como sistema coordenado para la 

presentación de los resultados: 

 

Main 

Menu>General Postproc>Options for Outp. 

 

En la ventana que aparece, seleccionar Local system para Results coord system y 

escribir el número 11. 
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Figura 20: Representación de resultados en el nuevo sistema de coordenadas local. 

 

Para determinar el factor de intensidad de tensiones Modo I: 

 

Main Menu>General Postproc>Nodal Calcs>Stress Int Factor. 

 

 

Figura 21: Solicitación del factor de intensidad de tensiones. 
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Forma alternativa del cálculo de KI mediante la integral J: 
 

7. Solución 
 

Para resolver el problema se escoge en el menú: 

 

Solution->(Analysis Type) New Analysis->Static->OK. 

 

Para calcular el factor de intensidad de tensiones, es necesario calcular previamente la 

integral J a lo largo de un contorno. Para ello se han de seguir los siguientes pasos 

escribiendo las correspondientes instrucciones en la barra de códigos de Ansys: 

 

a) Se selecciona el nodo del fondo de fisura (nodo 1): NSEL,S,LOC,X,a 

 NSEL,S,LOC,Y,0. 

 

b) Se concreta un nombre que defina el componente “nodo del fondo de fisura”. Hay 

que seleccionar el nodo 1 y a este componente lo llamaremos CRACKTIP: 

CM,CRACKTIP,NODE. 

 

c) A continuación se seleccionan todos los nodos: ALLSEL,ALL. 

 

d) Seguidamente se definen todos los parámetros asociados con los cálculos de la 

integral J de contorno. Esto se hace a través de la instrucción CINT: 

 

CINT,NEW,1 

 

NEW hace referencia a un nuevo cálculo de la integral de contorno J. 

 

1: es el número identificativo para dicha integral. 

 

CINT,CTNC,CRACKTIP 

 

CTNC define cual va a ser el nombre del componente nodal del fondo de fisura. 

 

CRACKTIP: es el nombre asignado al nodo 1 del fondo de fisura. 

 

CINT,SYMM;ON: el plano de fisura es, al mismo tiempo, un plano de simetría. Es 

por tanto necesario definirlo en Ansys: 

 

SYMM: propiedades de plano de simetría. 

 

ON: dichas propiedades se activan. 

 

CINT,NCON,6: número de contornos a ser calculados. En este caso, 6 contornos. 

 

CINT,NORM,0,2: Definición del sistema coordenado para el cálculo de la integral 

de contorno: 
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 NORM: Sistema coordenado. 

 

 0: Sistema coordenado cartesiano. 

 

 2: Eje perpendicular al plano de simetría es el eje Y. 

 

e) Seleccionar todos los nodos: ALLSEL,ALL 

 

Se procede a llevar a cabo la solución del problema, es decir, al cálculo de la integral J. 

 

Solution->(Solve)->Current LS. 

 

Se abre una ventana blanca resumiendo algunos datos de la simulación y una ventana 

verde indicando que, si después de leer el resumen se está de acuerdo con el tipo de 

cálculo, pulsando OK en la ventana verde se iniciará el cálculo.  

 

Cuando el cálculo ha terminado se muestra el mensaje “Solution is done”. Hay que pulsar 

OK y cerrar la ventana blanca que ha aparecido al iniciar el cálculo: File->Close. 

 

8. Obtención de los resultados 
Para visualizar los resultados del análisis hay que utilizar el módulo de postproceso del 

programa (General Postproc). Hay que obtener el valor del factor de intensidad de 

tensiones KI a partir del cálculo de la integral J. 

De la teoría se sabe que 𝐾| =
𝐸

1−𝜈2
|𝐽|

1

2  para deformación plana (para tensión plana sería 

𝐾| = 𝐸|𝐽|
1

2  ). 

 

Para mostrar los resultados es necesario seguir el siguiente itinerario: 

 

a) Listar los datos de la integral J resultante identificada con el número 1: PRCINT,1. 

 

b) Almacenar el valor de la integral en un parámetro J. Este valor de la integral es un 

escalar y se obtiene para el contorno 6: *GET,J,CINT,1,,1,,6. 

 

c) Mostrar el valor de J (integral de contorno): *STATUS,J. 

 

d) Se define una constante de propiedades elásticas del material: CON1=200000/(1-

(0.3*0.3)). 

 

e) Se define la ecuación del factor de intensidad de tensiones: 

K=(CON1*ABS(J))**0.5. 

 

f) Mostrar el valor de K: STATUS,K. 
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1. Enunciado 
 

El problema de una esfera de material elástico en contacto con un plano rígido se puede 

resolver de manera analítica resolviendo las ecuaciones del contacto, sin embargo, este 

tipo de problema también se puede aproximar utilizando el método de los elementos 

finitos (Ansys). 

Ahora, considere el problema consistente en una comparación entre la solución analítica 

y numérica (elementos finitos) del contacto entre una esfera de material elástico lineal y 

un plano rígido. Considere el caso particular en el que se aplica una fuerza descendente 

(F) de 180N a un objeto esférico con un radio (R1) de 8 mm. Esta esfera isotrópica tiene 

un módulo elástico (E1) de 2 GPa y un coeficiente de Poisson (ν1) de 0,3. Esta esfera se 

pone en contacto con un plano rígido, es decir, un sólido con módulo elástico (E2) igual 

a +∞ y un coeficiente de Poisson (ν2) igual a 0. 

 

 

Figura 1: Contacto entre plano infinitamente rígido y esfera. 

 

El problema se debe resolver utilizando un elemento PLANE182 2-D, que es un elemento 

de 4 nodos con funciones de interpolación lineales, con el comportamiento 

correspondiente a axisimetría, e integración completa (4 puntos de integración). Este 

elemento se utilizará en la esfera. El plano infinitamente rígido no requerirá de mallado 

ya que se definirá como un sólido rígido. Se dibuja la geometría según el plano de 

visualización XY (Figura 2), sabiendo que el eje de axisimetría es el eje Y.  

 

Hipótesis de partida: 

 

• Las superficies son continuas y no conformes, lo que significa que el contacto 

inicial entre la esfera y el plano es un punto, en nuestro ejemplo de la esfera. 

 

• Pequeñas deformaciones. 

 

• Los sólidos son elásticos. 

 

• Las superficies son sin fricción y la esfera no puede penetrar en el plano. 
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2. Preprocesamiento: Definir el problema  
 

Seleccionar el tipo de análisis que se va a realizar, en este caso estructural. 

 

Preferences> Structural. 

 

Figura 2: Elección del tipo de análisis a realizar. 

 

1) Asignar título a la simulación. 

 

Menú Principal> Archivo> Cambiar título. 

 

2) Generar la Geometría: Las operaciones booleanas se utilizarán para crear la 

geometría básica del componente.  

 

a) Crear la forma de semicírculo ya que la simulación será axisimétrica.  

La forma de semicírculo tiene un radio de 8 mm, con centro en (0,8) mm. Primero se 

crean unos keypoints que definen el círculo y el plano: 

 

Preprocessor -> Modeling -> Create -> Keypoints ->In active CS. 

 

A continuación, se introducen las coordenadas del centro y de los dos extremos del 

semicírculo, así como del final del plano:  

Número de keypoint, (X,Y,Z). 

 

1, (0,0,0) 

2, (0,8,0) 

3, (0,16,0) 

4, (8,0,0) 

5, (8,8,0) 
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Preprocessor -> Modeling -> Create -> Lines ->Arcs ->By End KPs and Rad. 

 

Para el arco superior, se seleccionan el punto 3 y el punto 5, se pulsa ok y se selecciona 

el punto 2. A continuación aparece el siguiente menú donde se pulsa ok y se crea el arco:  

 

Figura 3: Arco creado mediante el centro y dos puntos. 

 

Para el segundo arco se sigue el mismo procedimiento. 

 

b) Generar las líneas, tanto la que cierra el semicírculo como la del plano 

infinitamente rígido.  

 

Para crear una línea:  

 

Preprocessor -> Modeling -> Create -> Lines -> Straight Line. 

 

A continuación, se unen los keypoints 1 con 3. Se repite el proceso y se unen los keypoints 

1 con 4. 

 

c) Ahora se crea el área del semicírculo seleccionando todas las líneas que lo 

componen. 

 

 Preprocessor -> Modeling -> Create -> Areas ->By Lines. 

 

La figura resultante debería ser similar a la siguiente: 
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Figura 4: Geometría resultante de realizar las operaciones anteriores. 

 

3. Definición del tipo de elemento 

 

Para este ejemplo se empleará un elemento cuadrilátero de cuatro nodos, cuya 

designación es PLANE182. 

  

Preprocessor -> Element Type -> Add / Edit / Delete. 

 

Figura 5: Definición de un nuevo elemento. 

 

Seleccione la pestaña de Añadir (Add) y a continuación seleccione el tipo de elemento 

deseado: en este caso SOLID Quad 4 node 182. 
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Figura 6: Definición del tipo de elemento. 

 

Use "Opciones ..." botón para obtener un elemento que tenga en cuenta la axisimetría del 

problema. 

 

 

Figura 7: Definición de las características del elemento. 

 

4. Definición de los materiales 

 
Inicialmente es necesario introducir un parámetro, que será el módulo elástico E del 

material. Para ello se selecciona la opción de Parameters del menú principal. A 

continuación, se escoge la opción de Scalar Parameters. En Selection se introduce un 

valor inicial arbitrario del módulo elástico: 𝐸 = 2000 𝑁/𝑚𝑚2. 

 

Preprocessor -> Material Props -> Material Models -> Material estructural -> lineal 

-> elástico -> isótropo. 
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Figura 8: Selección del modelo de material. 

 

Se piden las propiedades del material que se han parametrizado anteriormente. Escriba lo 

siguiente cuando se le solicite: E, MU=0.3. 

 

5. Mallado 

 

Preprocessor -> Meshing -> Size Cntrls -> Manual Size -> Areas -> All Areas. 

 

Seleccione un elemento de longitud de la arista de 0.5 mm. 

 

 

Figura 9: Selección de la longitud característica del elemento. 

 

Preprocessor -> Meshing -> Mesh -> Areas -> Free y seleccionar el área cuando se 

le solicite. 
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Figura 10: Esfera mallada. 

 

6. Creación del contacto entre la esfera y el plano rígido 

 
Para crear el contacto, se selecciona el icono verde en la barra de herramientas arriba a la 

derecha “Pair Based Contact Manager” y aparece la siguiente ventana: 

 

Figura 11: Ventana para crear un contacto entre dos cuerpos. 

 

En el icono verde a la izquierda se selecciona crear un nuevo contacto: 

 

Figura 12: Definición de la superficie objetivo. 
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Para el “target” se selecciona línea y rígido ya que será el plano rígido. Se selecciona 

“pick target” y se selecciona la línea que representa el plano rígido. Se pulsa ok y next y 

aparecerá el siguiente menú: 

 

Figura 13: Definición de la superficie de contacto. 

 

Se selecciona “lines” y “surface tu surface” para la superficie de contacto que será la 

parte inferior de la esfera, en concreto el arco inferior. Se selecciona la línea del arco 

inferior y se pulsa ok y next. Aparecerá un menú que se deja por defecto y se pulsa en 

“create”. Aparecerá el siguiente mensaje: 

 

 

Figura 14: Creación del contacto entre los dos cuerpos. 
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Para que el contacto se produzca correctamente, las normales de los dos elementos, en 

este caso dos lineas, en contacto deben apuntar en la misma dirección, por lo tanto, habrá 

que cambiar de dirección la normal del “target”. Se selecciona la línea y se pulsa ok y 

aparecerá correctamente como en la siguiente imagen. Cuando esto ocurra, se pulsa en 

finalizar. 

 

 

Figura 15: Creación del contacto entre los dos cuerpos con las normales orientadas 

correctamente. 

 

Guardar su trabajo SAVE>Finish. 

 

7. Fase de solución: Asignación de Cargas y resolución 
 

Ahora es el momento de aplicar la fuerza y las condiciones de contorno y resolver el 

sistema resultante de ecuaciones. 

 

1) Definir el tipo de análisis: 

 

"Un nuevo análisis", "Solution"> y seleccione 'Static'. 

 

2) Aplicar restricciones: 

 

Al haber elegido elementos con axisimetría, el programa ya interpreta las restricciones de 

movimientos en las direcciones perpendiculares al eje por lo que no hay que añadir 

restricciones adicionales. Únicamente hay que restringir todos los movimientos. 

 

Solution -> Define Loads -> Apply -> Structural -> Displacement -> On lines. 
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Se selecciona la línea que representa al plano rígido. 

Haga clic en “Apply” y a continuación seleccionar, en la siguiente ventana que se abre, 

la opción de “All DOF” (todos los grados de libertad impedidos). 

 

3) Aplicar cargas: 

 

Como se muestra en el diagrama, hay una fuerza aplicada de 180 N en el punto superior 

del semicírculo. 

Para aplicar esta fuerza:  

 

Solution -> Define Loads -> Apply -> Structural -> Force -> On KeyPoints. 

 

Se selecciona el nodo superior sobre el que se aplicará la fuerza: 

 

 

Figura 16: Aplicación de la fuerza de 180 N. 

 

Finalmente, resolver mediante la opción:  

 

Solve -> Current LS. 

Pulse Finish. 

 

8. Fase de visualización: Campo de desplazamientos 
 

a) Determinar el radio de indentación: 

 

Para poder visualizar el campo de desplazamientos se opera de la siguiente manera: 

 

General Postproc ->Results Viewer ->Choose a result item ->Contact ->Contact 

status-> Plot results. 
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Figura 17: Visualización de los elementos en contacto con el plano rígido. 

 

Así se puede saber cuáles son los elementos que entran en contacto con el plano rígido. 

Por lo tanto, si se selecciona el último nodo en contacto, se pueden saber sus coordenadas 

x e y, y a partir de ahí con trigonometría básica calcular el radio de contacto. Para mirar 

sus coordenadas se procede del siguiente modo: 

 

General Postproc ->Results Viewer ->Choose a result item ->DOF Solution ->X-

Component. 

 

Para seleccionar el valor en un único nodo, en la misma ventana: 

 

File -> Edit ->Select entities ->OK ->Seleccionar el nodo deseado. 

 

Una vez seleccionado el nodo, en el cuarto icono de la ventana, “List results” aparece el 

desplazamiento en x del nodo seleccionado. 

 

Figura 18: Desplazamiento en x del nodo seleccionado. 
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Se debe repetir el mismo procedimiento para la coordenada y del nodo. 

 

b) Determinar la presión máxima en la zona del contacto (en Ansys el y): 

 

Para poder visualizar el máximo y el mínimo de las tensiones en y: 

 

General Postproc ->Results Viewer ->Choose a result item ->Stress ->Y-

Component. 

 

Seleccionar “List results” e ir al final donde aparecen el máximo y el mínimo de la 

tensión en y, entre otras: 

 

 
Figura 19: Máximo y mínimo de las tensiones en los nodos. 

 

El máximo en valor absoluto aparece en el nodo 1, que es el punto inicial en contacto con 

el plano. 

 

c) Determinar las tensiones normales a lo largo del eje z (en ansys el y). 

 

Para determinar los valores de un output a lo largo de una línea hay que seguir el siguiente 

itinerario: 

 

Main Menu->General Postproc->Path Operations->Define Path->By Nodes. 

 

Aparece el menú de selección Pick Menu. A continuación, se seleccionan los nodos con 

coordenadas (x, y) que definen la línea, y se pulsa Ok. El camino se extiende a lo largo 

del eje y, comenzando desde el punto en contacto con el plano infinitamente rígido y 

acabando por el punto de aplicación de la fuerza. 
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Figura 20: Path de nodos creado a lo largo del eje de la esfera. 

 

La ventana By Nodes aparece. Hay que introducir un nombre que describa el camino, por 

ejemplo, camino1, en el campo de texto: Define Path Name, y pulsar Ok. 

Se pueden presentar los resultados sobre el camino definido a través del siguiente 

itinerario: 

 

Main Menu->General Postproc->Path Operations->Map onto Path. 

 

Seleccionar Stress y dirección Y-direction SY, y pulsar Ok. 

Se puede obtener la línea de variación de las tensiones σyy a lo largo del camino definido 

mediante el siguiente itinerario: 

 

Main Menu->General Postproc->Path Operations->Plot Path Item->On Graph. 

 

A continuación, se selecciona SY y se pulsa Ok. La distribución de tensiones en y es la 

siguiente: 

 

 
Figura 21: Distribución de tensiones en y a lo largo del camino creado. 
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1. Objetivos 
 

El objetivo principal de la práctica consiste en presentar al estudiante las bases de los 

fundamentos teóricos del par mecánico leva-seguidor para la programación en Matlab de 

un código simplificado que permita calcular variables cinemáticas del seguidor. 

Con el fin de alcanzar el objetivo principal, se han fijado una serie de objetivos que el 

estudiante deberá alcanzar de forma secuencial. Dichos objetivos parciales son: 

 

• Comprensión completa y detallada de la explicación teórica proporcionada en este 

guion, así como de la explicación del profesor correspondiente en clase. Este 

punto es fundamental para poder abordar la programación del código. 

 

• Programación en Matlab de un código que deberá estar compuesto por un archivo 

principal .m y dos funciones para calcular las cuestiones correspondientes. 

 

• Una vez comprobado el correcto funcionamiento del código, se procederá a 

responder a las cuestiones planteadas en el último apartado. 

 

2. Fundamentos teóricos 
 

1. Introducción 

 

Un mecanismo es un conjunto de sólidos que transforman una energía entrante en una 

serie de movimientos mediante un sistema de transmisión. En la industria se utilizan 

distintas estrategias para transmitir el movimiento de un elemento mecánico a otro 

dependiendo del grado de idoneidad de cada una para una aplicación en concreto. Por 

ejemplo, existe la transmisión por fricción mediante correas de distribución o mediante 

la fuerza generada en un contacto directo como en el caso de los engranajes. 

Una leva es un mecanismo constituido por dos elementos, la leva y el seguidor. La leva 

es el elemento mecánico que transmite el movimiento, en general circular, al seguidor, 

transformándolo generalmente en un movimiento de traslación. Estos elementos se suelen 

utilizar en aplicaciones que necesitan una transmisión de movimiento de naturaleza 

irregular o compleja y no pueden reproducirse mediante mecanismos constituidos por 

eslabones. 

Un ejemplo claro de la utilización de levas es un motor de combustión de 4 tiempos. Las 

fases de un motor de combustión de 4 tiempos son: admisión, donde un set de válvulas se 

abre para dejar pasar la mezcla que provocará la ignición, compresión, donde todas las 

válvulas deben estar cerradas, expansión, donde todas las válvulas deben seguir cerradas 

y escape, donde un segundo set de válvulas se abre para dejar escapar los gases residuales. 

Los movimientos que necesitan las válvulas para seguir esta ruta se consiguen mediante 

elementos tipo leva que van acoplados a un cigüeñal que rota y trasmiten el movimiento 

a las válvulas correspondientes. En el siguiente video se puede ver la función del árbol de 

levas más claramente: 

 

https://www.youtube.com/watch?v=U__gOXOCrO8 
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Figura 1: Representación genérica del conjunto leva-seguidor. 

 

Normalmente el sistema leva-seguidor se diseña para la generación de trayectorias o 

funciones. El seguidor describe una determinada función de movimiento gracias a su 

contacto permanente con el perfil de una leva que tiene un movimiento de rotación. Por 

lo tanto, el perfil de la leva transmite la función de movimiento deseada al seguidor por 

contacto directo. De esta forma, la leva es el elemento conductor y el vástago es el 

elemento seguidor. Una leva puede mantenerse estacionaria, trasladarse, oscilar o rotar, 

mientras que el seguidor puede trasladarse, oscilar o ambos. 

 

2. Clasificación de levas y seguidores 

 

Las levas se pueden clasificar en dos grandes grupos; levas planas y levas espaciales. Esta 

práctica se centrará en las planas cuya característica principal es que el eje del movimiento 

de la leva y el eje del movimiento del seguidor son siempre perpendiculares: 

 

1) Leva de rotación con seguidor de traslación: Figura 1. 

 

2) Leva de rotación con seguidor oscilante: 

 

 

Figura 2: Leva de rotación con seguidor oscilante curvo. 
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3) Leva de traslación (o leva lineal) con seguidor de traslación: 

 

 

Figura 3: Leva de traslación con seguidor de traslación. 

 

4) Leva de traslación con seguidor oscilante: 

 

 

Figura 4: Leva de traslación con seguidor oscilante. 

 

Dentro de las levas espaciales se pueden encuadrar las levas cilíndricas, cuya trayectoria 

está contenida en un cilindro, cónicas, cuya trayectoria se encuentra contenida en un cono 

y glóbica que constituye un caso más general. 

Los tipos de seguidores se pueden clasificar en tres grandes grupos; según su movimiento, 

su forma y su posición. Esta práctica se centrará en la clasificación por forma: 

 

1) Seguidor de cuña, de filo de cuchillo o puntual: No se suele utilizar en la práctica 

por el excesivo desgaste que sufre la línea de contacto durante el movimiento de 

la leva. 
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Figura 5: Conjunto leva-seguidor con seguidor de cuña. 

 

2) Seguidor de rodillo: Es el diseño de seguidor más popular. Los seguidores de 

rodillos comerciales utilizan una bola o rodamientos de aguja soportados por un 

vástago. Estos seguidores tienen bajo coeficiente de rozamiento por lo que 

normalmente se utilizan en maquinaria de producción: Figuras 3 y 4. 

 

3) Seguidor de cara plana: Figura 1. 

 

4) Seguidor de cara esférica o superficie espacial curva. 

 

 

Figura 6: Conjunto leva-seguidor con seguidor espacial curvo. 

 

3. Estrategias para mantener el contacto leva-seguidor 

 

Como en cualquier otro par cinemático, en el par de leva es fundamental mantener el 

contacto entre los dos elementos. Existen diferentes estrategias para garantizar ese 

contacto: 

 

• Cierre de forma: El contacto se asegura por la forma en la que está construido el 

par y suele haber dos puntos ideales de contacto entre leva y seguidor. 
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Figura 7. Conjunto leva-seguidor con cierre de forma. 

 

• Cierre de fuerza: Se habla de par con cierre de fuerza cuando es necesaria la 

intervención de una fuerza (la gravedad o la fuerza que ejerce un resorte) para 

asegurar el contacto. 

 

 

Figura 8: Conjunto leva-seguidor con cierre de fuerza mediante un muelle. 

 

4. Geometría de levas radiales. Diseño del perfil de una leva 

 

La función de la leva es producir un determinado desplazamiento en el seguidor para un 

valor dado de la posición de la leva. Llamando θ e 𝑦 a los movimientos de la leva y del 

seguidor respectivamente, se debe diseñar la leva para satisfacer la función 𝑦 = 𝑦(θ). A 

dicha función se le denomina función de la leva y a su representación gráfica, diagrama 

de desplazamiento. Cada punto del diagrama de desplazamiento representa la posición 

del seguidor cuando la leva ha girado un determinado ángulo. Este diagrama se obtiene 

para el punto trazador y con él se obtiene la curva primitiva. Después, dependiendo de la 

forma del seguidor, se traza el perfil de la leva. 
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Así, en una síntesis de leva se requiere definir la geometría de la leva para que se produzca 

un desplazamiento definido del seguidor durante el movimiento de giro o traslación de la 

leva. 

 

 

Figura 9. Representación de los principales parámetros geométricos de una leva. 

 

A la vista de la figura anterior, se van a definir los parámetros geométricos más 

importantes: 

 

• Perfil de leva: Es la superficie de contacto entre leva y seguidor. 

 

• Punto trazador: Es el punto del seguidor que se toma como referencia de su 

movimiento. Se elige en el centro de un seguidor de rodillo. 

 

• Curva de paso: Es la trayectoria que describe el punto trazador en su movimiento 

relativo respecto a la leva. 

 

• Línea de acción: Es la normal común a las superficies de contacto. 

 

• Ángulo de presión: Es el ángulo complementario del ángulo de transmisión, es 

decir, el ángulo que forma la dirección del movimiento del seguidor (o dirección 

de su vector velocidad) con la línea de acción. 

 

• Punto de transición: Es aquel punto del perfil de leva donde se produce el contacto 

en el instante en el que la velocidad del seguidor es máxima. 

 

• Punto de paso o punto primitivo: Es la posición a lo largo de la curva de paso 

donde es máximo el ángulo de presión. 

 

• Circunferencia de paso: Es aquella que tiene su centro en el eje de giro de la leva 

y pasa por el punto de paso. 
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• Circunferencia primitiva: Es la menor circunferencia con centro en el eje de la 

leva y tangente a la curva de paso. También se llama circunferencia primaria. 

 

• Elevación o carrera: Es la distancia recorrida por el seguidor entre dos posiciones 

extremas. 

 

5. Geometría de levas radiales. Diseño del perfil de una leva 

 

El diagrama de desplazamientos del seguidor definido por la función 𝑦 = 𝑦(θ) puede 

tener subidas, bajadas o permanecer en reposo. Las subidas y bajadas del seguidor se 

suelen modelar mediante funciones matemáticas; perfiles cicloidales, armónicos, 

parabólicos, lineales, polinómicos de orden superior, etc. Dichas funciones o perfiles se 

eligen dependiendo de la aplicación en la que se vaya a utilizar el conjunto leva-seguidor, 

por ejemplo, es común utilizar el perfil cicloidal en aplicaciones donde se desea 

minimizar vibraciones porque los diagramas de posición, velocidad, aceleración y 

sobreaceleración son muy suaves y no presentan picos. 

 

 

Figura 10. Leva con diagrama de desplazamientos. 

 

Las expresiones para el perfil lineal y cicloidal son las siguientes: 

 

𝑦(θ) = 𝐿
θ

𝛽
 con 0 ≤ θ ≤  𝛽  𝑆𝑢𝑏𝑖𝑑𝑎 𝐿𝑖𝑛𝑒𝑎𝑙  

 

𝑦(θ) = 𝐿 (1 −
θ

𝛽
)  con 0 ≤ θ ≤  𝛽  𝐵𝑎𝑗𝑎𝑑𝑎 𝐿𝑖𝑛𝑒𝑎𝑙 

 

𝑦(θ) = 𝐿
θ

𝛽
−

L

2𝜋
sen (2𝜋

θ

𝛽
)  con 0 ≤ θ ≤  𝛽  𝑆𝑢𝑏𝑖𝑑𝑎 𝐶𝑖𝑐𝑙𝑜𝑖𝑑𝑎𝑙 

 

𝑦(θ) = 𝐿 − 𝐿
θ

𝛽
+

L

2𝜋
sen (2𝜋

θ

𝛽
)  con 0 ≤ θ ≤  𝛽  𝐵𝑎𝑗𝑎𝑑𝑎 𝐶𝑖𝑐𝑙𝑜𝑖𝑑𝑎𝑙 

 

Donde 𝒚(𝛉) es la posición del seguidor, 𝛉 es el ángulo girado por la leva, 𝑳 es la carrera 

y 𝜷 es el ángulo total del intervalo de subida o bajada. 
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Se debe tener en cuenta que estas expresiones están dadas para un tramo que empiece en 

θ = 0, si el intervalo no empieza ahí, las expresiones sufrirán alguna modificación. 

 

3. Programación del código en Matlab 
 

Se pretende programar un código en Matlab para obtener los diagramas de 

desplazamiento, velocidad, aceleración y sobreaceleración de un seguidor en contacto 

con una leva de rotación sin excentricidad. La leva tiene tres tramos diferentes, un primer 

tramo de subida, un segundo tramo de reposo y un tercer tramo de bajada. Los perfiles 

que se pueden utilizar tanto para la subida como para la bajada son perfiles lineales y 

cicloidales. El programa consta de un archivo principal .m donde el usuario deberá 

introducir por teclado los siguientes datos: 

 

• La velocidad angular de la leva en rad/s. 

 

• El radio base de la leva en mm. 

 

• Si el seguidor es de punta o de rodillo y en su caso el radio del rodillo. 

 

• La carrera en mm. 

 

• Los ángulos que definan los tres intervalos considerados en rad. 

 

• Si el movimiento de subida es lineal o cicloidal y si el movimiento de bajada es 

lineal o cicloidal. 

 

• El número de puntos para la discretización de los tres tramos. 

 

Una función “gráficas” que devuelva los vectores de posición, velocidad, aceleración y 

sobreaceleración del seguidor así como el vector de tiempos y el vector de ángulos. Una 

función “valores” que permita introducir un valor de ángulo o de tiempo y devuelva los 

valores de la posición, velocidad, aceleración y sobreaceleración del seguidor en ese 

punto. Por último en el archivo principal se deben representar las gráficas de las variables 

cinemáticas del seguidor frente al tiempo o frente al ángulo, según elija el usuario.  
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4. Resultados. informe final de la práctica 
 

Una vez programado el código y comprobado el correcto funcionamiento del programa 

rellenar la siguiente tabla para los siguientes casos: 

 

• Caso 1: Tramo 1 [0º,90º] subida lineal, tramo 2 [90º,220º] reposo, tramo 3 

[220º,360º] bajada cicloidal, 1000 puntos de discretización para cada uno de los 

tres tramos, seguidor de cuchillo, 𝜔 = 2 𝑟𝑎𝑑/𝑠, 𝑅𝑏 = 20 𝑚𝑚, 𝐿 = 10 𝑚𝑚. 

 

• Caso 2: Tramo 1 [0º,80º] subida cicloidal, tramo 2 [80º,150º] reposo, tramo 3 

[150º,360º] bajada lineal, 500 puntos de discretización para cada uno de los tres 

tramos, seguidor de rodillo, 𝜔 = 1 𝑟𝑎𝑑/𝑠, 𝑅𝑏 = 25 𝑚𝑚, 𝐿 = 15 𝑚𝑚, 𝑟 =
2 𝑚𝑚. 

 

θ(º) 
Posición 

(𝑚𝑚) 

Velocidad 

(𝑚/𝑠) 

Aceleración 

(𝑚/𝑠2) 

Sobreaceleración 

(𝑚/𝑠3) 

60 (Caso 1)     

200 (Caso 1)     

320 (Caso 1)     

50 (Caso 2)     

100 (Caso 2)     

210 (Caso 2)     

Tabla 1: Tabla de variables cinemáticas a rellenar para los dos casos propuestos. 

 


